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            Rietveld texture analysis from TOF neutron diffraction data H.-R. Wenk a University of California, Berkeley, California 94720 L. Lutterotti University of Trento, Trento, Italy 38123 S. C. Vogel Lujan Center, LANSCE, Los Alamos National Laboratory, Los Alamos, New Mexico 87545 Received 24 February 2010; accepted 3 June 2010 One of the advantages of a multidetector neutron time-of-ﬂight diffractometer such as the high pressure preferred orientation diffractometer HIPPO at the Los Alamos Neutron Science Center is the capability to measure efﬁciently preferred orientation of bulk materials. A routine experimental method for measurements, both at ambient conditions, as well as high or low temperatures, has been established. However, only recently has the complex data analysis been streamlined to make it straightforward for a noninitiated user. Here, we describe the Rietveld texture analysis of HIPPO data with the computer code Materials Analysis Using Diffraction MAUD as a step-by-step procedure and illustrate it with a metamorphic quartz rock. Postprocessing of the results is described and neutron diffraction results are compared with electron backscatter diffraction measurements on the same sample. © 2010 International Centre for Diffraction Data. DOI: 10.1154/1.3479004 Key words: texture analysis, neutron diffraction, Rietveld method, quartzite I. INTRODUCTION The orientation of crystals in a polycrystalline aggregate or texture has a profound inﬂuence on physical properties, most importantly, anisotropy of bulk properties which are a function of anisotropic properties of single crystals and the orientation distribution. Texture has long been studied in metals as well as rocks see Kocks et al. 2000 for details and applications and we assume that the reader is familiar with the basic principles of texture analysis. Texture or crys- tallographic preferred orientation describes the orientation of crystallites of phases that compose a material relative to sample coordinates with a three-dimensional 3D statistical orientation distribution function ODF. The ODF can be cal- culated from measured pole ﬁgures of lattice planes hkl. In the case of neutron TOF diffraction data the ODF is obtained directly as described below, but for representation we will use the more familiar pole ﬁgures, which have been calcu- lated from the ODF. Textures are not only important for me- chanical properties; they are also essential for crystal struc- ture reﬁnements and volume fraction estimates of aggregates with preferred orientation. Various techniques are used to determine texture, most commonly X-ray, electron, and neutron diffraction e.g., Wenk, 2006 and Wenk, 2011. Neutron diffraction has unique advantages for texture analysis because of high pen- etration combined with comparably large beam spot sizes. The information derived from the diffraction data is averaged over a large volume typically in the order of a cubic centi- meter; therefore, sampling statistically signiﬁcant numbers of grains even in coarse-grained aggregates and special sample environments are possible. Time-of-ﬂight TOF neu- tron diffraction is increasingly used to record textures of bulk materials, providing the additional advantage of determining textures of low symmetry phases e.g., Brown et al., 2006; Xie et al., 2003, of composites with complex diffraction patterns e.g., Ivankina et al., 2005; Wenk et al., 2001, or in situ experiments at high/low temperature e.g., Bhatta- charyya et al., 2006; Lonardelli et al., 2007; McDaniel et al., 2006; Wenk et al., 2007 and stress Hartig et al., 2006. Since the Rietveld approach Rietveld, 1969 is used to ex- tract the texture information, it does not rely on single well- resolved diffraction peaks, as pole ﬁgure gonio metersdo, which are used for constant wavelength neutrons or X-rays. Neutron diffraction is most efﬁcient with multidetector spec- trometers such as high pressure preferred orientation HIPPOat LANSCE, Los Alamos; Vogel et al., 2004; Wenk et al., 2003, GEM at ISIS, U.K.; Day et al., 2004, or SKAT at the Joint Institute for Nuclear Research, Russia; Ullemeyer et al., 1998, where each detector records a spec- trum of crystals with lattice planes in reﬂection orientation. It is not trivial to advance from diffraction spectra to quantitative orientation distributions. The Rietveld method Rietveld, 1969, as implemented in the General Structure Analysis System GSASLarson andVon Dreele, 2004; Von Dreele, 1997 and MAUD Lutterotti et al., 1997, has proved to be a very powerful tool for texture analysis. Other Ri- etveld softwares such as FULLPROF Rodríguez-Carvajal, 1993 or RIETAN-FP Izumi and Momma, 2007 do not con- sider full texture analysis but merely offer corrections for preferred orientation and are thus limited to crystal aggre- gates with random orientation distributions or special cases such as orientation of plate-shaped crystallites in powders Dollase, 1986. Here, we are not addressing methods or im- portant applications of neutron diffraction texture analysis but focus speciﬁcally on the Rietveld method with MAUD, as applied to HIPPO data, providing an efﬁcient hands-on pro- cedure. Apart from data input with the MAUD wizard de- scribed below, the procedure is equally applicable to any a Author to whom correspondence should be addressed. Electronic mail: [email protected] 283 283 Powder Diffraction 25 3, September 2010 0885-7156/2010/253/283/14/$30.00 © 2010 JCPDS-ICDD 
        

        
    






				            

        

    









                
                    Rietveld texture analysis from TOF neutron diffraction dataeps.berkeley.edu/~wenk/TexturePage/Publications/2010-HIPPO-PD.pdfRietveld texture analysis from TOF neutron diffraction data


                    
                                                Download PDF
                        
                        Report
                    

                    
                        	
								Upload

									others
								

							
	
                                View

                                    8
                                

                            
	
                                Download

                                    0
                                

                            


                    

                    
                    
                        
                        
                            
                                    
Facebook

                        

                        
                        
                            
                                    
Twitter

                        

                        
                        
                            
                                    
E-Mail

                        

                        
                        
                            
                                    
LinkedIn

                        

                        
                        
                            
                            
Pinterest

                        

                    


                    
                

                

                    
                    Embed Size (px)
                        344 x 292
429 x 357
514 x 422
599 x 487


                    

                    

                    
                                        Citation preview

                    Page 1
						

Rietveld texture analysis from TOF neutron diffraction dataH.-R. Wenka�
 University of California, Berkeley, California 94720
 L. LutterottiUniversity of Trento, Trento, Italy 38123
 S. C. VogelLujan Center, LANSCE, Los Alamos National Laboratory, Los Alamos, New Mexico 87545
 �Received 24 February 2010; accepted 3 June 2010�
 One of the advantages of a multidetector neutron time-of-flight diffractometer such as the highpressure preferred orientation diffractometer �HIPPO� at the Los Alamos Neutron Science Center isthe capability to measure efficiently preferred orientation of bulk materials. A routine experimentalmethod for measurements, both at ambient conditions, as well as high or low temperatures, has beenestablished. However, only recently has the complex data analysis been streamlined to make itstraightforward for a noninitiated user. Here, we describe the Rietveld texture analysis of HIPPOdata with the computer code Materials Analysis Using Diffraction �MAUD� as a step-by-stepprocedure and illustrate it with a metamorphic quartz rock. Postprocessing of the results is describedand neutron diffraction results are compared with electron backscatter diffraction measurements onthe same sample. © 2010 International Centre for Diffraction Data. �DOI: 10.1154/1.3479004�
 Key words: texture analysis, neutron diffraction, Rietveld method, quartzite
 I. INTRODUCTION
 The orientation of crystals in a polycrystalline aggregate�or texture� has a profound influence on physical properties,most importantly, anisotropy of bulk properties which are afunction of anisotropic properties of single crystals and theorientation distribution. Texture has long been studied inmetals as well as rocks �see Kocks et al. �2000� for detailsand applications� and we assume that the reader is familiarwith the basic principles of texture analysis. Texture or crys-tallographic preferred orientation describes the orientation ofcrystallites of phases that compose a material relative tosample coordinates with a three-dimensional �3D� statisticalorientation distribution function �ODF�. The ODF can be cal-culated from measured pole figures of lattice planes �hkl�. Inthe case of neutron TOF diffraction data the ODF is obtaineddirectly as described below, but for representation we willuse the more familiar pole figures, which have been calcu-lated from the ODF. Textures are not only important for me-chanical properties; they are also essential for crystal struc-ture refinements and volume fraction estimates of aggregateswith preferred orientation.
 Various techniques are used to determine texture, mostcommonly X-ray, electron, and neutron diffraction �e.g.,Wenk, 2006 and Wenk, 2011�. Neutron diffraction hasunique advantages for texture analysis because of high pen-etration combined with comparably large beam spot sizes.The information derived from the diffraction data is averagedover a large volume �typically in the order of a cubic centi-meter�; therefore, sampling statistically significant numbersof grains even in coarse-grained aggregates and specialsample environments are possible. Time-of-flight �TOF� neu-tron diffraction is increasingly used to record textures of bulk
 a�Author to whom correspondence should be addressed. Electronic mail:
 [email protected] 283 Powder Diffraction 25 �3�, September 2010 0885-7156
 materials, providing the additional advantage of determiningtextures of low symmetry phases �e.g., Brown et al., 2006;Xie et al., 2003�, of composites with complex diffractionpatterns �e.g., Ivankina et al., 2005; Wenk et al., 2001�, or insitu experiments at high/low temperature �e.g., Bhatta-charyya et al., 2006; Lonardelli et al., 2007; McDaniel et al.,2006; Wenk et al., 2007� and stress �Hartig et al., 2006�.Since the Rietveld approach �Rietveld, 1969� is used to ex-tract the texture information, it does not rely on single well-resolved diffraction peaks, as pole figure gonio metersdo,which are used for constant wavelength neutrons or X-rays.Neutron diffraction is most efficient with multidetector spec-trometers such as high pressure preferred orientation�HIPPO� �at LANSCE, Los Alamos; Vogel et al., 2004;Wenk et al., 2003�, GEM �at ISIS, U.K.; Day et al., 2004�, orSKAT �at the Joint Institute for Nuclear Research, Russia;Ullemeyer et al., 1998�, where each detector records a spec-trum of crystals with lattice planes in reflection orientation.
 It is not trivial to advance from diffraction spectra toquantitative orientation distributions. The Rietveld method�Rietveld, 1969�, as implemented in the General StructureAnalysis System �GSAS� �Larson and Von Dreele, 2004; VonDreele, 1997� and MAUD �Lutterotti et al., 1997�, has provedto be a very powerful tool for texture analysis. Other Ri-etveld softwares such as FULLPROF �Rodríguez-Carvajal,1993� or RIETAN-FP �Izumi and Momma, 2007� do not con-sider full texture analysis but merely offer corrections forpreferred orientation and are thus limited to crystal aggre-gates with random orientation distributions or special casessuch as orientation of plate-shaped crystallites in powders�Dollase, 1986�. Here, we are not addressing methods or im-portant applications of neutron diffraction texture analysisbut focus specifically on the Rietveld method with MAUD, asapplied to HIPPO data, providing an efficient hands-on pro-cedure. Apart from data input with the MAUD wizard �de-
 scribed below�, the procedure is equally applicable to any 283/2010/25�3�/283/14/$30.00 © 2010 JCPDS-ICDD
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other TOF neutron diffraction data that are available in GSAS
 format. Also, the emphasis is on texture analysis, not oncrystal structure refinement, microstructure, or residualstress.
 MAUD is not restricted to neutron diffraction. It is usedfrom two-dimensional �2D� X-ray diffraction images �e.g.,Lonardelli et al., 2005�, microstructural investigations �e.g.,Lutterotti et al., 2004�, and X-ray crystal structure analysis�e.g., Lutterotti and Bortolotti, 2005�. Therefore, there aremany options in MAUD that are not used for neutron diffrac-tion texture analysis and this can make it overwhelming forbeginners.
 MAUD is not yet an established package like GSAS butconstantly evolving, as new scientific applications requireexpansion and modifications. It is not a black box where youenter data and get results, and therefore it is not foolproof �noreference to FULLPROF!�. For many applications there is nosimple procedure and the user has to be familiar with manyof the complexities. TOF neutron diffraction, one of the earlyMAUD applications �Lutterotti et al., 1997�, is an exceptionand here we want to guide a user with a step-by-step proce-dure through data analysis that is applicable to most routinesamples, specifically for the LANSCE HIPPO diffractometer.Do not use this procedure for other applications such as tex-ture analysis from synchrotron diffraction images. It is as-sumed that the reader is familiar with the general geometryof HIPPO �e.g., Wenk et al., 2003�. We will discuss a few ofthe many options that apply to neutron diffraction �especiallyin Sec. VI�. MAUD is written in JAVA and works with anyoperating system for which a Java implementation is avail-able �WINDOWS, MAC OS X, LINUX, and UNIX�. For our dem-onstration we use WINDOWS XP. It should be noted that due tothe complexity of the program and large data arrays, MAUD
 requires large memory �1 Gbyte is sufficient for most cases�and, while an analysis is running, users should refrain fromrunning many other procedures at the same time, especiallytwo simultaneous MAUD refinements.
 We apply MAUD to determine the texture of a sample ofamphibolite facies metamorphic quartzite from the BergellAlps, measured in the HIPPO automatic sample changer Re-iche and Vogel, 2010. The sample was roughly cylindershaped with 1 cm diameter and 1.25 cm height �Figure 1�.The data files as well as an instrument parameter file withinformation on instrument geometry can be downloadedfrom MAUD websites �http://www.ing.unitn.it/~maud/tutorial.html and http://eps.berkeley.edu/~wenk/TexturePage/MAUD.htm�.
 II. GETTING STARTED
 When measuring textures, it is of critical importance toknow the orientation of the sample relative to the diffractioninstrument and thus the diffraction vectors relative to thesample for all spectra. Obviously, it is equally important torecord and preserve the specimen orientation relative to theinvestigated larger scale object, e.g., a rolled plate or geo-logical formation. Samples need to be oriented and thenmounted in a systematic manner, for example, with an arrowpointing to a reference notch in a HIPPO sample holder �Fig-ure 1�. This yields the ODF and pole figures relative to the
 sample coordinate system such as the cylinder axis and the 284 Powder Diffr., Vol. 25, No. 3, September 2010
 arrow. Samples mounted on the sample holder’s aluminumrod hang into the sample chamber with the aluminumshielded by neutron absorbing cadmium. If the latter is notapplied properly, spurious peaks of aluminum would be ob-served and an additional phase might have to be added to theanalysis.
 For texture measurements with HIPPO, typically720-3He-detector tubes, distributed over 30 detector panelsand arranged on three banks �150, 90, and, 40°2��, are used.Individual detector tubes of a detector panel are first cor-rected for variations in diffraction angle, then added �binned�at LANSCE, and finally exported in GSAS format �.gda files�.For very coarse-grained samples with poor grain statistics itis advisable to inspect the raw binary data sets showing thehistograms from each individual tube. This allows us to de-termine if the sample consists of only a few single grains andin such cases statistical texture analysis does not apply. Theraw data are generally not distributed to users since the datasets are very large ��25 Mbytes per run�. A software pro-gram to inspect those data sets is ISAW, which is availablefrom the ORNL neutron portal at http://neutrons.ornl.gov/portal/. In addition to the binned data, the instrument scien-tist provides an instrument parameter file �.prm�, obtained bymeasuring two standards �sample position and incident inten-sity�, containing information about the geometry and calibra-tion of the diffraction instrument.
 The sample coordinate system in MAUD is defined bythree right-handed cartesian, x, y, and z, and correspondingrotations, �, �, and �, in that order �Figure 2�a��. Theserotations are the MAUD defined as positive for clockwise ro-tation �rotation axis pointing towards the viewer� and are thesame as those of a standard texture goniometer, which meansthe rotation axes move when a rotation is applied. We willlater explain how to apply a � rotation of 90° to bring theHIPPO sample holder rotation axis into the center of the polefigure. After such a rotation around the neutron beam axis,
 Figure 1. Cylinder of rock, marked with an arrow to indicate orientation,mounted on a sample holder, with a characteristic notch.
 the detectors plot on the pole figure as shown in Figure 2�b�.
 284Wenk, Lutterotti, and Vogel
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With the 30 detectors typically used for texture measure-ments, HIPPO has a large pole-figure coverage. Figure 2�b�displays the angular range that each detector panel views andthus the resolution that we can expect �Matthies et al., 2005�.In the data analysis we generally assume that detector dataare representative of a point in the center of the polygon�Figure 2�c��. Note that the coverage pattern of Figure 2�c� isrotated �61.7° around � versus Figure 2�b�. This is due toan offset of the rotation around the vertical axis introducedby the geometry of the HIPPO sample changer. Coveragecan be improved by rotating the sample about the verticalaxis into three or more different positions �Figure 2�d��.Typical rotations in the sample changer, furnace, or cryostatare �=0°, 4°, 67.5°, and 90°. Positive numbers assume thatrotations are counterclockwise.
 Each measurement of a given orientation with HIPPOtakes between 1 and 60 min, depending on the volume andcomplexity of the sample. Thus, with four rotations, a mea-surement is done in less than 1 h for most samples. With theautomatic sample changer up to 16 samples can be measuredautomatically, without operator interaction.
 III. ENTERING DATA
 1. Download the latest version of MAUD from the web�http://www.ing.unitn.it/~maud/� and install it on yourcomputer in a separate directory. Be aware that MAUD isbeing updated periodically. You also need a recent version
 Figure 2. �a� Sample coordinate system in MAUD with three orthogonal axesand corresponding rotations �, �, and �. �b� Pole figure coverage in theHIPPO TOF diffractometer. Neutron beam enters from the top. The area ofeach detector panel is displayed. Relative to Figure 2�a� the system has beenrotated 90° around � to bring the HIPPO rotation axis into the center of thepole figure. �c� Initial orientation in sample changer ��=0°� with �offset=−61.7°. �c� four rotations to improve coverage. Equal area projection.
 of JAVA �version 6 or higher is preferred: http://
 285 Powder Diffr., Vol. 25, No. 3, September 2010
 java.sun.com/javase/downloads/index.jsp�. JAVA is not in-stalled by default in the WINDOWS operating system andthe open source JAVA implementation preinstalled on mostLINUX distributions �e.g., UBUNTU� at present is not suit-able to run MAUD �install the last SUN version from theprevious link�. Also, download the HIPPO demo data setinto your computer and store it in a separate directory.Then start MAUD. If you start MAUD for the first time itwill ask you to accept the license and where to store ad-ditional files. It is most convenient to have those in theMAUD directory. The MAUD console window will outputinformation during the operation that can be useful toidentify problems.
 2. The menu option “File→New→Hippo Wizard” opens awindow �Figure 3� that allows you to conveniently importthe experimental data and prepare them for the automaticanalysis.
 3. In the Hippo Wizard window, input a title describing thedata set.
 4. Select the parameter file that corresponds to your data byclicking on the “Browse” button next to the “Choose cali-bration file” field �for this demonstration we usehippo_sc_050819_30panel.prm from the demo data�. Af-ter defining the instrument parameter file, select data fileswith the second browse button �for example, 14445.gda to14448.gda�.
 5. Assign each data file a rotation angle omega �for the testsample: 0° for 14445.gda; 45° for 14446.gda; 67.5° for14447.gda; and 90° for 14448.gda�. The bulk rotation,“Omega offset” ��61.7°�, accounts for the HIPPO samplechanger oddity that the sample holder notch is displacedfrom the incident beam direction at 0° rotation angle. Ap-plying this rotation realigns the sample, with the arrowpointing to the top in the reconstructed pole figures. Clickon each file again to verify that the angles were assignedcorrectly.
 6. Click “Next” and choose the d ranges to be considered foreach detector bank. This range depends on the number ofpeaks in your patterns. For instance, if the maximum re-
 Figure 3. HIPPO Wizard in MAUD to load instrument parameter file and datafiles.
 flection d spacing is at 2.3 Å, choose a maximum d spac-
 285Rietveld texture analysis from TOF ...
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° det
 ing of 2.5 Å since all data above this upper limit representonly background. For this example, we use 1 to 2.75 Å.Data at lower d spacings do not improve the analysis �inthis case� because of the large number of overlaps. Re-stricting the range also speeds up the computation. Gen-erally, you consider each bank and each rotation as a dif-ferent instrument and refine instrumental parametersaccordingly—namely, the scaling factors and conversionfactors for TOF to d spacing �DIFC�. Hence, leave thecorresponding option in the dialog checked.
 7. “Finish” the Wizard. This returns you to the main MAUD
 page. Data are displayed either as average profile �Plot tabpanel on the right hand side of the main window� �Figure4� or as a stack of all spectra for a given “Instrument”�Plot2D tab panel� �Figure 5�. There are various optionsfor graphic displays: they can be selected in the mainmenu “Graphic→Plot options” or in “Analysis→Preferences.” For this presentation we use black andwhite representation. For Plot this is in “Preferences” un-der the “plot.black&white” key “true” and for Plot2D in“Preferences” under the “Multiplot2D.grayscale” key“true” �Preferences are in alphabetical order, first uppercase, then lower case�. In the menu “Graphic→Plot op-tions” we choose “sqrt” for intensity scale �log 10 scalesare used mainly for reflectivity analysis plotting�. Thereare various options for X scale, 2�, d spacing, or Q, de-pending on the application. Background can be subtractedor plotted separately �in Figures 4 and 5 we do not sub-tract background�. Spectra can be displayed normalized
 Figure 4. Main MAUD page with Plot display for 150
 with the incident spectrum �“Calibration correction,” as
 286 Powder Diffr., Vol. 25, No. 3, September 2010
 defined in the instrument parameter file�; the refinement,however, uses actual intensities. We can also select fontand font size.
 8. You may now inspect your data using the “Plot2D” paneland by clicking on each “Dataset.” Note the bottom �first�spectrum of the 90° bank detectors has a much lowerintensity �Figure 5� due to partial shielding of tubes by thesample changer and we may want to remove it from theanalysis. Edit the data set in the “Datasets” panel �“Edit–Edit Object” or the “eye” shortcut in the middle of thetoolbar, just under “Special”�. On the window that opensthere is a variety of information about your data �Figure6�. Editing “Diffraction Instrument” �press the “Edit” but-ton in the instrument panel� displays details about theexperimental setup. In the case of TOF neutron diffrac-tion, the HIPPO Wizard has already initialized all impor-tant information �subwindow in Figure 6�. For other TOFdiffractometers you may have to modify some entries. Onthe main window �Figure 6� you may modify the compu-tation range or you can exclude some regions from thespectrum. The units are d spacings for TOF neutron dif-fraction �converted from TOF in the .gda file�, 2� forangular dispersive experiments, and energy for energydispersive experiments. Choosing “Datafiles” opens awindow with the individual diffraction spectra, includingorientation angles �Figure 7�. The orientation angles areinitialized for HIPPO data by the HIPPO wizard. Forother instruments or other rotations in HIPPO, e.g. arounda horizontal axis instead of the vertical axis, the proper
 ectors: enter the data sets and disable faulty spectra.
 sample orientation angles need to be entered here. The
 286Wenk, Lutterotti, and Vogel
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angle � defines the azimuth angle of HIPPO detectorsaround the incident beam for a given Bragg angle. Toexclude the first spectrum �14445.gda �9��, disable thefirst spectrum on the list �No. 9� for all four 90° banks.�Select the spectrum and click on the “Enabled” checkbutton to disable. By default each data set and datafile inthe data set is enabled.�
 9. Next, click on the “Phases” tab and load phases. This caneither be done from a cif file which you have downloadedfrom a database �such as the free COD database, contain-ing more than 100’000 phases at present, http://www.crystallography.net/, Grazulis et al. �2009�, or theequally free Mineralogical Society of America databasehttp://rruff.geo.arizona.edu/AMS/amcsd.php, Downs andWallace-Hall, 2003� or access structures coming with theMAUD installation in the file structures.mdb. Select fromthe principal menu “Edit” and “Load phases from CIFdata base or file…” or click the left arrow icon in thetoolbar. You can create your own version of the struc-tures.mdb file by exporting crystal information in MAUD
 to it for further use �right arrow icon in the toolbar�. Youcan also enter your own crystal structure information�space group, lattice parameters, atomic coordinates, etc.�using the “Add new object” in the menu for the “Phases”tab and then the “Edit object” command. For this ex-ample, use “Quartz” from the MAUD database �Figure 5�.Looking at the structure data �with “Edit object”�, we seethat temperature factors B�=8�2Uiso� for Si and O arezero. The reason is that the cif file contains anisotropictemperature factors which are currently not loaded in
 Figure 5. Main MAUD page with Plot2D display for 90° detectors: disable f“structures.mdb” window is shown� and edit the sample.
 MAUD from cif files. Zero is not realistic and we enter
 287 Powder Diffr., Vol. 25, No. 3, September 2010
 “1.0” for each instead. We will later refine the tempera-ture factor but keep it the same for all atoms. Temperaturefactors generally vary between 0.2 and 1.5 for most atomsand crystal structures at ambient temperature. Also, notethat if we use the HIPPO wizard, automatically neutronscattering lengths for natural isotope abundances of ele-ments are applied. In case other isotopes are required,they can be specified in the “Edit object” window underthe tab “Structure” by pressing on the button to select theelement type. In case more than one isotope is present andnot in natural abundances, enter each isotope as a separateatom site with corresponding occupancies. If multiplephases are present, repeat this step for each phase.
 10. Edit each phase, and in the “Advanced Models” tabcheck that “Le Bail” is the actual “Structure Factor Ex-tractor” �this is the default for the HIPPO wizard�, thenchoose E-WIMV as a texture method. Under the textureoptions �press the “Options” button for the texturemethod�, select an ODF resolution between 7.5° and15°, which approximates the angular resolution ofHIPPO �Figure 2�b��. Here, we use 15°. You can alsoimpose sample symmetry after you verify that the datawarrant it and your sample is properly oriented; i.e., thesymmetry axis of a fiber symmetric texture is in thecenter of the pole figures �no symmetry is imposedhere�. You can use the “Sample position” window �under“Sample window” to reorient the sample with respect tolaboratory coordinates to ensure correct symmetry. Un-der “E-WIMV Advanced Options” you can restrict thenumber of reflections that are used in the texture refine-
 spectra, such as the one at bottom �No. 9�, then enter phases �the database
 aulty ment either by intensity or by d spacing �we use defaults
 287Rietveld texture analysis from TOF ...

Page 6
						

0., 0.�. �On the main window, in “Analysis-Options”make sure to “Enable texture extraction” at “end of it-eration” which is the default�.
 11. If you need the sample rotation axis in the center of thepole figure, edit the “Sample” and under “Sample posi-tion” choose �=−90°. This orients the system such thatthe sample changer rotation axis is perpendicular to theplane of the pole figure. In the final pole figure �Figure10� you are looking down on the sample hanging inHIPPO, with the face of the sample glued to the holderfacing the viewer and the arrow pointing to the notchlocated at 12 o’clock. To obtain pole figures viewing thesample standing on the holder as shown in Figure 1 and
 Figure 6. Data set window with options to edit “Diffraction Instrument”Backgrounds, as well as changing Computation range.
 the arrow pointing to the notch at 6 o’clock �the conven-
 288 Powder Diffr., Vol. 25, No. 3, September 2010
 tional setting�, the sample position angles need to be setto �=−90° and =−180°. You can verify the relationbetween instrument and pole figure coordinate system byplotting the pole figure coverage at any time �in“Graphic–Texture plot”�—the 90° detectors have a char-acteristic gap for the HIPPO door, which allows us toidentify the direction of the incident beam. The imple-mentation of the E-WIMV algorithm in MAUD �see be-low� requires that for strong textures �pole densities�10 multiples of a random distribution �m.r.d.��, thestrongest pole figure maxima to be preferably near thecenter of the pole figure, otherwise the differences insampling density may result in artifacts. If a strong tex-
 dow for HIPPO parameters is inserted�, Datafiles, Excluded regions, and
 �Win ture is observed after the first analysis with the strongest
 288Wenk, Lutterotti, and Vogel
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can
 maxima on the rim of the pole figure, reorient the sampleaccordingly in the “Sample” tab. Three rotations aroundorthogonal axes are shown in Figure 2�a�. The first rota-tion is �, second is �, and last one is �; all rotations areclockwise. For polyphase materials you can enter initialestimates of the volume fractions in the “Layers” dialogof the “Sample” tab �default is equal weight fractions foreach contributing phase�. These volume fractions willlater be refined.
 12. At this point, you should save your analysis in your datadirectory �from main menu: “File→Save analysis as”�as a “.par” file �we use Brg980-Quartzite.par�. Save theanalysis after each successful refinement cycle. Thenyou may re-load the file later and choose “Analysis-Compute Spectra” to re-initialize the values, e.g. for tex-ture plotting, without the need of a full analysis. Now
 Figure 7. Datafiles window which
 you are ready to start the refinement.
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 IV. RIETVELD REFINEMENT
 During the least-squares refinement you may look at pa-rameters, e.g., lattice parameters, on the parameter list panelon the bottom of the main window. You can also view themin “Phase” by selecting the corresponding phase object tofind the cell parameters. It is advised not to open the “Editphase” window during refinement. This may interfere withthe least-squares routine if you modify something. Even ifyou modify nothing, it is important to close these framesusing the button on top of the window �on WINDOWS XP thesmall button with an “X” in the title bar on the top right ofthe window� and not using the “OK” button. The latterchanges or refreshes the parameters in midst of the refine-ment and may cause the optimization routine to computewrong quantities and behave erratically.
 For simple analyses/materials you can use an automated
 be used to disable certain spectra.
 procedure �and this is the case for our example�. Under the
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menu “Analysis” select “Wizard.” In the appearing windowchoose “Texture Analysis” in the right panel and press thebutton “Go!” You may watch the progress of the refinementin the graphics window �Figures 4 and 5�. The automaticprocedure with the Wizard will refine the most importantparameters in four cycles. Select no more than five iterations�this can be adjusted as the refinement proceeds with theproper indexed scroll bar in the iteration output panel of themain window�. To guarantee convergence, you may, at theend, perform three to five additional iterations �selectingfrom the menu “Analysis→Refinement”�.
 The texture wizard works well for single-phase materialsand clearly defined compounds with a light/medium texture.For complex materials you need to proceed in individualsteps using the menu “Analysis→Parameter List” andspecify manually the parameters to refine. You can also ini-tially use the wizard to set up automatically the parametersand adjust them later. To do this, in the wizard select thecycle step you want to perform �left panel� and press the “Setparameters” button instead of “Go!” Then open the param-eter list window to manually select the parameters to be re-fined. The parameter list is also displayed at the bottom ofthe main window and by setting the “Status” of an individualparameter to “Refined” it is allowed to vary. Using the“Equal to” option constraints between parameters may beintroduced �e.g. atomic positions of atoms on shared sites areforced to remain the same�.
 If you do everything manually you may proceed as fol-lows: fix all parameters first �using the corresponding button“Analysis→Parameter List”�, then free backgrounds andscale parameters �with corresponding buttons�, and thenclose the parameter list window and perform a refinement�“Analysis→Refine” in the main menu�. Next, add to therefinement “Spectra Monitors→TOF Bank SF” �with thebuttons in the parameter list window� and finally “Texture,”depending on how the procedure converges. Section VI willdiscuss some of the options.
 Be aware that the least-squares procedure refines manyparameters �over 1000 in many cases�. Most parameters arecomplex nonlinear functions and the total model used to de-scribe the experimental data and deviations from these datais a surface with many subsidiary minima. If too many pa-rameters are refined from unrealistic starting positions, thenthe refinement may converge into subsidiary minima ratherthan the true solution or lead to divergence. It is thereforeimportant to have starting parameters as close as possible tothe true solution. If necessary, parameters can be adjustedmanually. Use “Datasets” → “Datafiles”, select a spectrumand “View.” With “Tools” → “Change parameter” you canchange parameters manually and immediately see the result.
 Below we only consider the “Texture Wizard.” Thecycles for the automatic refinement of the texture are thefollowing:
 Cycle 1: Refining the scale factors, background param-eters, and phase fractions for multiphase systems. The cali-brated incident intensity parameters �12 parameters� are di-rectly loaded from the HIPPO calibration file and then keptconstant. A single scale factor is refined for each detectorpanel, accounting for differences in detector efficiency orvarying attenuation along the path between sample and de-
 tector. Backgrounds are expressed with a polynomial. Three 290 Powder Diffr., Vol. 25, No. 3, September 2010
 background coefficients are refined for each bank �by defaultonly three background coefficients but more can be added�and, in addition, two background coefficients for each pat-tern �view in “Datasets—Datafiles—Additional param-eters”�. After the cycle, the background starts to look reason-able and so does the overall intensity �Figure 8�. Note thatthe high-angle 150° bank detectors �Figure 8�a�� have amuch higher resolution, i.e., narrower peaks, than the 40°bank �Figure 8�b��, but lower counting statistics, i.e., noisierdata. Texture is not yet reflected in the recalculated spectra�top of Figure 9�a��. Also, the wavy line is not matched dueto mispositioning of the sample, which is particularly seriousfor the 40° bank.
 Cycle 2: In addition to the previous parameters, peakpositions are adjusted during this cycle by refining cell pa-rameters and the conversion parameters for TOF to d spacingconversion based on observed d spacings. This essentiallycorrects for sample alignment problems which may originateeven from changes in position of the center of gravity of thescattering power relative to the calibration material due tochanges in the scattering power of the material. The wavi-ness is corrected �Figure 9�b��.
 Cycle 3: The microstructural parameters �crystallite sizeand microstrains� are added to the refinement to adjust peakshapes. There are several methods to refine crystallite sizeand lattice strain �see also Sec. VI�. In this example we use asimple isotropic model, which is the default. Only one over-
 Figure 8. The fitting of scale factors and backgrounds for �a� 150° and �b�40° bank average spectra �cycle 1�. Note the much higher angular resolutionof the high-angle detector, but poorer counting statistics. Spectra are notnormalized.
 all temperature factor, B, is used for all atoms of all phases to
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avoid correlations and minimize possible errors. Other struc-tural parameters, such as atomic coordinates, are not refinedwith the texture wizard. You may refine them separately atthe end, including individual isotropic temperature factors,but this requires excellent resolution and counting statistics.
 Cycle 4: The orientation distribution is refined with thechosen texture extraction method, in our example theE-WIMV algorithm �Matthies and Vinel, 1982; more options
 Figure 9. Texture Wizard with multiplots illustrating refinement stages in �a�cycle 1, �b� cycle 2, and �c� cycle 4 for 40° detectors of �16.7 rotation. Topcalculated; bottom observed.
 are briefly discussed in Sec. VI�. Intensities of individual
 291 Powder Diffr., Vol. 25, No. 3, September 2010
 peaks start to match �Figure 9�c��. Warning: the interactivePlot2D display only shows the real calculated pattern at theend of each cycle. In between it may indicate a perfectmatch, but this is due to temporary fitting by the Le Bailextraction, not true texture intensities.
 The procedure with the Wizard does not automaticallyrefine all possible parameters for all phases. For example,crystallite size and microstrains are not refined for phasesthat are below a certain threshold. The default threshold�0.001� can be changed in “Analysis→Preferences” “wiz-ard.riet_refine_sizestrain_over” key.
 After this refinement, several checks need to be per-formed. The overall quality of the least-squares refinement isexpressed in R or Rwp factors, with 5% to 15% for a good fit.These numbers are also included in the file generated by“Analysis→Results.” There are separate R factors for tex-ture and overall refinement because the WIMV and E-WIMVmethods use their own algorithms to fit the experimentaltexture data extracted with the modified Le Bail procedure�Matthies et al., 1997�. However, R factors are only a bulkmeasure �e.g., Toby, 2006� and do not provide details aboutpotential problems. Refining more parameters may provide abetter fit �lower R factors� but adding parameters is onlyjustified if these parameters are constrained by the actualdata. The best evaluation of a satisfactory refinement is tocompare observed �bottom� and calculated �top� intensitiesfor all detectors on the multiplots �“Plot2D,” Figure 9�c��. Inthe “Datasets” editing window under “Datafiles” select thespectra, one or more at time, and press the “View” button toget a closer look at observed and calculated intensity spectra.The “Plot” panel on the main window can be misleading forevaluating the fit. It is a simple average over all spectra for adata set and does not take complex texture relationships intoaccount.
 If the results appear reasonable, close all windows, ex-cept the main window, then select “Graphic→Texture Plot”to display the checked pole figures �Figure 10�. “Recon-structed intensity” shows pole figures of selected latticeplanes hkl calculated from the ODF. “Experimental inten-sity” displays normalized Le Bail factors. In this windowyou can also confirm that you have the correct “Pole figurecoverage” �Figure 2�d��. Particularly for texture publicationswe generally prefer gray shades for density mapping �click“Gray shaded” on “Texture plotting” page�. Colors may bemore glamorous for presentations, but, if colored pole figuresare copied on a black-white printer, the pole densities be-come unintelligible, with both minima and maxima appear-ing dark. More details about texture representation are givenin Sec. VI.
 The Wizard refinement is often sufficient to capture themain texture features. You may wish to continue to refineadditional parameters from the many possibilities offered byMAUD. They include lattice parameters for accessory phases,atomic coordinates, temperature factors, anisotropic grainsize, and residual stresses. This can be done in “Analysis→Parameter List,” fixing the ones you do not want to refineand refining those you do by selecting them in the list andchanging their status to “Refinable.” Otherwise, you can editthe individual parameters in the individual edit windows �forphases, data sets, instruments, and sample�, and select them
 to refine �by pressing the right mouse button when over any 291Rietveld texture analysis from TOF ...
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of the parameter text fields�. Be aware that the refinement islimited by the quality of the data. For TOF neutron diffrac-tion there is some inherent uncertainty about the sample po-sition and correspondingly absolute lattice parameter values.Also, for HIPPO peak resolution, even for 150° detectors, isnot extreme and thus information, e.g., on residual strainmay not be possible to extract.
 V. EXPORTING TEXTURE DATA
 For further processing of the texture data, the ODF canbe exported as an ASCII file �in the E-WIMV options win-dow� in BEARTEX format �.mod� �Wenk et al., 1998�. ODFdensities in m.r.d. are interpolated for 5° 5° cells.Then, in BEARTEX �http://eps.berkeley.edu/~wenk/TexturePage/beartex.htm� the MAUD format is first convertedto the standard binary format in routine CMAU. Subse-quently, it is smoothed to alleviate the rigid cell structure byapplying a 7.5° Gauss filter �SMOO�. With this smoothedODF you can then calculate pole figures �PCAL� and plotthem as shown in Figure 11�a� �PING� in a format that ispreferred for publications. From the continuous ODFweighted individual orientations can be generated for use inpolycrystal plasticity simulations �ODFW�. Also, you canuse this ODF to calculate polycrystal physical properties�TENS�. In CSEC you can rotate the sample coordinate sys-
 Figure 10. Texture plot window and selected 011, 101, and 003 pole figuresbottom.
 tem.
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 As a comparison, we analyzed the same quartzite samplewith the scanning electron microscope using the electronback-scattered diffraction �EBSD� method. For EBSD, 5824orientations were used, then smoothing the ODF with a 15°filter and rotating the EBSD-ODF to get it into the sameorientation as the neutron pole figures �Figure 8�b��. The twosets of pole figures are similar, including pole densities, butEBSD data that rely on much smaller numbers of grainsshow stochastic effects and are statistically less relevant�Matthies and Wagner, 1996; Matthies et al., 2005�, under-lining the main advantage of neutron texture analysis.
 An interesting feature of this quartz texture is that 101poles align perpendicular to the schistosity �center of thepole figure�. Mechanical twinning causes this feature and thepattern can be used as a paleopiezometer to unravel the stresshistory �Wenk et al., 2006�. Also, in the resolution of positive�101� and negative rhombs �011�, which are required forsuch analysis, neutron diffraction excels over EBSD. WithEBSD some of the pseudohexagonal orientations that definethe trigonal symmetry may be misindexed.
 VI. DISCUSSION OF SOME OPTIONS
 In this section we are discussing some options for ad-vanced MAUD users.
 lot. The actual plot of pole figures �reconstructed intensity� is shown at the
 to p �a� We have already mentioned the “Preferences” ASCII file.
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Defaults are generally appropriate but occasionally you maywant to change them. The “Preferences.Maud” file is storedin the MAUD directory and any changes will be applied per-manently. Below are some keys for preferences that youmight want to change:
 Multiplot2D.grayscale �default is false�: controls the2D plotting in colors or B/W
 log_output.fullResults �default is false�: generate longor short listing log output
 plotExpPF.minimumDistanceDeg �default is 10�: inthe experimental pole figure plot, control how farfrom measured point the interpolation goes
 wizard.riet_remove_phases_under �default is 0.01�:remove automatically phases from refinements whenbelow 1% volume fraction �these are set to zero�.
 �b� Where are the results? Results �with standard deviations�are stored in the parameter list �on main MAUD page�. Theyare also contained in the ASCII file “Results” with informa-tion about the refinement as well as a reflection list withintensity, size and strain information, and texture. This file iswritten as a “lst” file in the directory of parameter and datafiles. For E-WIMV the “lst” file contains normalized poledensities for all ODF cells in gamma sections.
 Parameters, including errors, can also be exported as anASCII file that can later be processed by EXCEL, etc. In“File,” choose “Append Simple Results to…” or “AppendResults to.…” For “Append Simple Results” first create anempty text file in your data directory. For “Append Results”you also need to create a text file, but in this case it will onlywrite parameters for which, in the parameter list, the optionfor “Output” has been set to “true.” By default all are set to“false.”
 �c� Background options. Two types of background are re-fined. One is for each detector and one for each spectrum.For the detector background there are various options. Oftena polynomial is used. It is not advisable to use more thanfour coefficients �default with the HIPPO wizard is 3�. Alter-natively backgrounds can be interpolated between manuallyset values or points chosen automatically by the routine �us-ing the method described by Sonneveld and Visser �1975� in
 Sec. III�. MAUD does not interpolate the background on the 293 Powder Diffr., Vol. 25, No. 3, September 2010
 experimental pattern, but to avoid using peak intensities asbackground, it computes the interpolation on the experimen-tal pattern after subtraction of the intensities due to phasereflections. This way the choice of the points becomes lessimportant. Background functions for each spectrum areadded in “Datafiles→Additional parameter” and two coeffi-cients are generally sufficient. In most cases the defaults ofthe HIPPO wizard are adequate and the user does not have toworry about it. For interpolated backgrounds there is a spe-cific tab panel next to the one for the polynomial generalbackground in the data set editing window. Manual pointscan be chosen graphically in the plot.
 �d� Texture models. There are various texture models imple-mented in MAUD �“Phases→Advanced Models→Texture”�.This is not the place to discuss texture analysis in detail andwe refer to standard texts �e.g., Kocks et al., 2000; Matthieset al., 2005�. Some methods are in direct space �WIMV,E-WIMV, and ideal components�. There is also the option touse the harmonic method which works in Fourier space. Formost applications the E-WIMV method is preferred. Themain options are the cell size �generally between 5 and 15�and sample symmetry. However, sample symmetry shouldonly be imposed after it has been verified that it statisticallyexists and the sample has been properly oriented �fiber sym-metry around center of pole figures, orthorhombic symmetrywith horizontal and vertical symmetry axes, etc.�. The cellsize depends to some extent on the pole figure coverage bydata. In order to provide a solution, each ODF cell must becovered by at least one data point �and preferably more�, i.e.,the coverage must be 100%. On the E-WIMV option panelthe ODF hits can be viewed �at least one hit per cell� as wellas ODF weights which are interpolated, taking neighboringcells into account. If the coverage is less than 100%, eitherthe cell size must be increased or more data need to be added�e.g., larger d range� or a method such as harmonic or idealcomponents must be applied. The texture refinement relieson the Le Bail factors �Le Bail et al., 1988�, i.e., the fractionof the experimental intensity and the structure factor with notexture present. In the “E-WIMV→Advanced Options”panel weak reflections can be excluded from the texture cal-culation. This is useful to avoid artifacts.
 Figure 11. Pole figures of c axes �001� and positive�101� and negative rhombs �011� of trigonal quartz, re-calculated from the ODF and plotted with BEARTEX forpublication quality. HIPPO data �top� and EBSD data�bottom� for the same sample. Equal area projection,upper hemisphere.
 �e� Texture representation. All texture analyses rely on the
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ODF which is a 3D function describing the crystal orienta-tion frequency of crystallite orientations represented insample coordinates. The latter is done with the Euler anglesand there are various conventions such as �1 ,� ,�2 �Bunge,1965�, � ,� ,  �Roe, 1965� with  =�1−90°, �=�, and�=�2+90°. MAUD uses the formulation �, �, and � of Mat-thies and Vinel �1982� that is identical to Roe. The overalltexture strength can be evaluated with the Texture Index F2�Bunge, 1982�, but a more satisfactory representation is the3D ODF which can be viewed in rectangular coordinates orin less distorted cylindrical coordinates �Wenk and Kocks,1987�. Often textures are represented as pole figures �insample coordinates for one crystal lattice plane normal �hkl�or symmetrically equivalent sets �hkl�� or inverse pole fig-ures �in crystal coordinates for one sample direction� whichare 2D projections of the ODF. These graphic representationsare available in “Graphic→Texture plot” and there are vari-ous options. Note that all pole densities �ODFs as well aspole figures� are normalized to express densities as m.r.d.The “Texture plotting” routine allows us to plot ODFs, polefigure coverage, reconstructed pole figures, and experimentalintensity �in “Preferences” “plotExpPF.minimumDis-tanceDeg,” the range of interpolation can be set �default is10��. The pole figure coordinate system depends on how thesample has been mounted in the diffractometer and how“Sample position” has been set. For inverse pole figures�001� is in the center and the pole to �100� to the right. Threeinverse pole figures are plotted for normal direction �ND�,rolling direction �RD�, and transverse direction �TD�. ND isnormal to the pole figure �z in Figure 2�a��, RD is pointingvertically �x in Figure 2�a��, and TD horizontally �y in Figure2�a��. Often ODFs and pole figures are exported as ASCIIfiles for further processing in other programs.
 �f� Line broadening is convoluted by two terms: instrumentand sample broadenings. The first one depends on instrumentsetup �only slightly on sample dimension and transparency�and can be kept constant as it was determined during theinstrument calibration. Instead the second part of the broad-ening can be different for each phase and in MAUD is the onlybroadening that should be refined during an analysis. Thissimplifies the refinement for the HIPPO user, as he will onlyrefine two parameters �crystallites and microstrain meanvalue� for each phase instead of refining all Caglioti param-eters for each phase �Caglioti et al., 1958; Caglioti et al.,1960�. The instrument broadening is described by the for-mula for the TOF profile function as described in the GSAS
 manual �Larson and Von Dreele, 2004� and is loaded directlywith the instrument parameter file.
 For the microstructural broadening there are different op-tions available in MAUD. The default model uses two param-eters �mean crystallites and microstrain “Delft” method� forisotropic broadening �Eqs. 6 and 7 of Lutterotti and Scardi�1990��. If one phase exhibits anisotropic broadening themethod of Popa �1998� can be selected where the crystalliteand microstrain anisotropy is described by a harmonic ex-pansion and the crystallographic symmetries are imposedthrough the Laue group of the phase. The best fit with thesmaller expansion should be pursued. Another model for an-isotropic broadening is the “anisotropic–no rules.” Themethod is described by Lutterotti and Scardi �1992�. In this
 model crystallographic symmetries should be imposed simi- 294 Powder Diffr., Vol. 25, No. 3, September 2010
 larly to what is done for anisotropic temperature factors us-ing the point symmetry. The last model available can useboth the isotropic or anisotropic model but instead define adifferent way to compute the peak profile and to convolutecrystallite and microstrain effects. It is called “distributions”and instead of a defined profile function it computes the peakshape from Fourier transforms of the convoluted crystallitesand microstrain distributions. The crystallite distributionsemployed are described by Popa and Balzar �2002� and themicrostrain distribution was used by Lutterotti and Scardi�1992�. It is composed of two terms: a mean microstrain anda “slope” coefficient to account for dislocations or defectsdistributed inside the grain or at the grain boundary.
 When revising the results for anisotropic broadening, ingeneral do not rely on 3D grain shape representation �whenavailable� but rather on the size in different lattice directionshkl �under “Results”�. For microstrain refinement, a mediumlarge d range is required. MAUD can be used to refine struc-tural features of amorphous materials as described by Lut-terotti et al. �1998�. For planar defects additional models canbe selected from the Warren description of planar faulting toa single layer model for turbostratic disorder �Lutterotti etal., 2010�.Be aware that neutron diffraction data may not have suffi-cient resolution to refine rms microstrain and particle sizeand generally no attempt should be made to refine thoseparameters, even if R factors improve.
 �g� Absorption. One of the advantages of neutrons is that formost materials there is excellent penetration and absorptionis minimal. However, there are cases where absorption needsto be considered, e.g., in the analysis of texture in silvercoins with a very high neutron absorption �Xie et al., 2004�.The shape can be entered in “Sample” “Sample Dimensions”“Shape model.” The “Harmonic integration” is slow since itdivides the sample into discrete cells and evaluates corre-sponding ray paths. The “Harmonic coefficient” method ismuch faster and uses a simple approximation.From the point of view of the user interface the two methodsprovide a similar panel and parameters. The only differenceis that in “Harmonic integration” there is an additional fieldto control the number of divisions for the integration pathand we just describe the “Harmonic coefficient” one. Themodel uses the same description of sample shape as the Popamodel �Popa, 1998� to describe the anisotropic crystallitesize. In analogy to that method, the user needs to choose theLaue group for the sample shape symmetry and the maxi-mum harmonic expansion term �Lmax�. Lmax should be theminimum number that permits to describe sufficiently theabsorption by the sample. We point out that especially for the“Harmonic coefficient” model, due to the approximationsused, the goal is not to get the real shape of the sample butthe best correction for the absorption. Shape may not corre-spond to the real one. Other options are needed to providesufficient flexibility for the model to work in different con-ditions. Sample orientation angles permit to rotate the coor-dinate system for the absorption correction. This way thesymmetry of sample shape/absorption can be decoupled fromthe texture sample symmetries. The velocity absorption cor-
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parameters are the model weight and the standard size. Thefirst controls the weight between absorption in reflection andin transmission.
 The model in its approximation considers two differentpaths inside the sample. The first path connects the center ofthe sample with the two points intersecting the incident anddiffracted beams with the sample surface �only a line passingthrough the center is considered for computing speed rea-sons�. The second path connects directly these two points. Inreflection the first path is long and the second is short. Intransmission both are long. Weighting between the two pathspermits to refine a balance between transmission or reflectionmodes. We have found that a good starting value is 0.3 andthe parameter should be refined only towards the end of therefinement if necessary. The last parameter �Standard size� isjust a commodity value to speed up convergence. We havefound that changing the overall size of the sample shapechanges the overall intensity of the diffraction a lot, muchmore than any other parameter. In practice this prevents aneffective refinement of the sample dimension and shape orthe change in their parameters is very slow. The “Standardsize” parameter normalizes the sample dimension by itsvalue. So the program can change more quickly the sampleshape coefficients counterbalancing the change in shape di-mension by refining also this size normalization value tokeep the same overall intensity. Therefore, this standard sizeparameter should be refined along with the harmonic coeffi-cients. Absorption pole figures can be plotted from the tex-ture plot window. This absorption model has been used in thepast efficiently in cases of irregular shapes �Artioli et al.,2003; Xie et al., 2004; Volz et al., 2006�.
 �h� For multiphase materials, the contribution of individualphases to the diffraction pattern in the “Plot” representationcan be evaluated by right clicking on the phase label in theplot. It will show different phases with different colors.
 �i� Magnetic scattering. At present only a simple “conemodel” �Hastings and Corliss, 1962� is implemented. One ofthe advantages of neutrons is that they are sensitive to mag-netic scattering and can be used to determine magnetic polefigures �Birsan et al., 1996; Brockhouse, 1953; Bunge,1989�.
 VII. CONCLUSION
 Quantitative texture analysis is of critical importance toevaluate deformation processes both of man-made as well asnatural materials. It is also the basis for determining aniso-tropic physical properties of polycrystalline aggregates.Since crystallite orientation affects diffraction intensities,consideration of texture is also crucial for evaluating volumefractions and for crystal structure refinements of materialsthat have preferred orientation. The Rietveld texture analysisof HIPPO-TOF neutron diffraction data with MAUD has beenapplied to a wide range of samples such as metals �e.g.,Matthies et al., 2005�, ceramics �e.g., Jones et al., 2005�, aswell as rocks �e.g., Pehl and Wenk, 2005�, including high-temperature conditions inside a furnace �e.g., Bhattacharyyaet al., 2006; Lonardelli et al., 2007; Wenk et al., 2009�.These procedures will, no doubt, be further refined, and we
 hope that this brief introduction will make texture analysis 295 Powder Diffr., Vol. 25, No. 3, September 2010
 more palatable for uninitiated HIPPO users, as well as usersof other TOF neutron diffractometers. HIPPO is availablethrough the LANSCE user program, see http://www.lansce.lanl.gov. Remember the four steps: �1� load theHIPPO data with the HIPPO Wizard, �2� enter phase �orphases�, and �3� refine with the Analysis Wizard �Texture�,�4� export the orientation distribution in E-WIMV, and cal-culate pole figures in BEARTEX. A sample without majorcomplexities is finished in 1 to 2 h on an average PC.
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